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Chapter 0 Getting Started

In this part, we give an overview of the general concepts and tools that involve 
spreadsheets. The spreadsheet software we use is Microsoft’s Excel 2013 in the MS-Windows 7
environment, but the principles should hold for any current software package. 

a. Spreadsheets Introduction 

One could argue that the advent of spreadsheet and word-processing software ushered in 
the PC as a primary tool in every workplace. In today’s world, wherever there is a table of data, 
it is stored in a spreadsheet. Some of the things one can do with data via spreadsheets are:

Data Arrangement  
Calculation  
Database Management 

Visualization 
Statistical Analysis 

Predictions 
Optimization

Spreadsheet packages also come with powerful built-in programming languages, making their 
versatility almost limitless. The best part about spreadsheets is that the initial learning curve is 
very short! We use Microsoft Excel 2013 for all demonstrations in this manual, but due to the 
standardization in today’s spreadsheets, one should be able to apply this material to almost any 
spreadsheet package. Throughout this manual, spreadsheet and PC terminology will be used. In
Figure 1, the typical window one sees is displayed with many of the names we use in this 
manual.

Figure 1
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2 Chapter 0 Getting Started

b. Files 

Collections of sheets are stored in files called workbooks. When you open Excel, it starts 
with a brand new workbook called “Book1”. Figure 1 is very close to what you will see. Notice 
the title of the workbook in the title bar at the top of the window. If you want to open a 
previously saved workbook, you can do so through the “File” (top left corner), or you can open it 
directly by finding the file and double-clicking it. 

Each workbook consists of sheets, accessed via the sheet tabs at the bottom of the screen
(Figure 1). Each sheet can be either a chart or a worksheet. Charts are any kind of visualization 
of data, such as scatter plots or bar graphs. Worksheets are the “spreadsheets,” the place where 
we (and the program) do all of the work.  

c. Cells 

Everything begins with the cell. If you can understand exactly what a cell is and what 
properties it has, the rest should be relatively easy. It is crucial that you understand this section.

A cell is one of the many rectangles you see on a worksheet. One or more cells are 
selected when they are surrounded by a bold outline with a fill handle in the lower right-hand 
corner of the outline (we will discuss the purpose of the fill handle later). You can select a single 
cell by clicking on it, and you can select a rectangular set of them by left-click-dragging. Figure 
2 shows the range B3:D6 selected.

The cell’s primary function is to hold and display “stuff”. The cell has four major 
attributes, which you need to learn: address, content, value, and format.

d. Cell Address

The address of a cell is indicated by the row and column in which it sits. (If you have 
ever played Battleship, you know exactly how this works!) The horizontal column heading is 
always one or two letters (ranging from A to XFD) and the vertical row heading is always a
number (from 1 to 1048576). A cell’s address consists of the column letter(s) and the row 
number. For example, if a cell sits in column B and row 3, then its address is B3 (Figure 3). 
Note: The address of the selected cell is given in the name box.

Figure 2
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Chapter 0 Getting Started 3

When a rectangular range (array) of cells is selected, the address of the range is given by 
the address of the upper left cell and the lower right cell, separated by a colon. In Figure 2 the 
upper left cell of the selected range is B3 and the lower right cell is D6: thus, the range is 
denoted by B3:D6. Note: When a range of cells forms a single column or row, the two end cells 
are used to denote the range. 

e. Cell Format 

A cell can contain many things, like numbers and text, but how the cell displays those 
things can vary greatly. Suppose you type into every cell of a range (say B1:B5) the number 
0.75. Without any formatting, the cells all display 0.75. By right-clicking a cell, you bring up a 
plethora of options, including “Format Cells”. The first tab you get in the “Format Cells” pop-up
window is “Number” (Figure 4). Here is where you can format the cell to display its value as 
anything from dates to currency. You can even dictate how many decimal places the cell will 
display (which can cause Excel to round the displayed value but not the actual value). In Figure 
5 you can see some of the possibilities, where all the cells contain the same value.

f. Cell Content 

The content of a cell is whatever you type into it, which is usually a number, text, or a 
formula. The content of the cell is not necessarily what the cell displays! In other words, you 
may enter a formula into a cell, but then what the cell displays is the value of the formula, while 
the content of the cell is the formula. Whenever you select a cell, the content of the cell is shown 
in the formula bar. For example suppose you select a cell, type the formula "=0*3+3/4", and 

Figure 4 Figure 5

Figure 3
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4 Chapter 0 Getting Started

press “Enter”. If you formatted the cell as a percentage, then the cell will display the value 75%. 
Now reselect the cell and look in the formula bar: you should see the formula "=0*3+3/4" 
(Figure 6).  

This is what makes spreadsheets so powerful. You will be able to enter formulas into 
cells that use values from other cells. In turn, these other cells may contain formulas themselves.

There is something very important to remember when using longer, more complicated 
formulas in Excel. Excel does not correctly obey the standard order of operations! Recall from 
basic algebra that an exponent applies only to whatever is to its immediate left. Unfortunately, 
Excel is programmed to apply negation (the negative sign) before applying exponents, whether 
parentheses are present or not. So the formula "= –A1^2" will return the value of (-A1)^2,
instead of the negative of (A1)^2. Therefore, when using Excel, you should adopt the convention 
of enclosing the base and the exponent in parentheses. Figure 7 shows the result of three 
different formulas. If you wish to calculate   -32= -9, then you should use the formula shown in 
the last column of the table.

g. Cell Value 

Every cell has a numeric value, even an empty one (which has a default value of 0). If 
you type a number into a cell, then that will also be the cell’s value. If you type a numeric 
formula into a cell, then that cell’s value will be the outcome of the formula. When the cell 
contains text or has a formula that returns text, then the value of that cell will default to 0. 
Remember that the value of a cell, what the cell displays, and the cell’s content are three 
different things. As seen in the example illustrated in Figure 6, the value of the cell is a 0.75, 
while the cell’s content is the formula "=0*3+3/4" and the cell’s display is 75%.

h. Formulas 

As seen earlier, you can type formulas into a cell. All formulas start with an “=”. A 
formula can have numbers, algebraic operations, functions, and addresses for cells and ranges. 
Notice that we do not have variables in the form x, y, .z... Any time we want to use a value from 
another cell in a formula, we can instead use the cell’s address simply by clicking on it or by 
typing the cell’s address. Let us consider an example. 

Figure 6

Figure 7
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Chapter 0 Getting Started 5

Suppose you wanted to store in cell D2 the average of three numbers that you have stored 
in cells B1, B2 and B3. This can be done with a formula. In cell D2, type "=(B1+B2+B3)/3" and 
press “Enter”. The cell D2 displays the average. If you reselect cell D2, the formula bar will 
display the formula that the cell contains, while the cell displays its value 2 (Figure 8).  

For many common calculations, such as averaging, there are built-in functions. To view a 
list of these functions, click on a cell and type “=”. The name box changes and becomes a drop-
down list of functions you have used recently, but for our purposes the most interesting choice is 
“More Functions" (Figure 9). Through this choice, you can explore and use a whole host of 
functions; it is certainly worth your while to check this out! Another way of obtaining a function 
is by clicking on “Formulas” tab and then on fx in the ribbon. Select your function from the newly 
appeared pop-up screen. You can also type in functions directly if you know the correct spelling
and appropriate arguments. Even if you remember and type the only the first letter of the function 
name after “=” Excel will help you remember the rest by offering several choices of functions 
beginning with that letter. In Figure 10 , the function "=AVERAGE(B1:B3)" gives the same result 
as the formula in Figure 8.

i. Copy, Paste, and Fill 

When copying cells, if the cell’s content is anything other than a formula, the contents are 
identically transcribed. However, when the content of a copied cell is a function, then the 
addresses within the function are adjusted by the relative distance from the copied cell to the 
pasted cell. 

As an example, consider Figure 11, where you have a table of values of which you want 
the average of each column. Type in the appropriate formula for averaging the first column in 
A4, and then copy that cell and paste it into the cell B4 under the next column (Figure 12). 
Notice how the address range, A1:A3, is shifted by exactly one column value to B1:B3. This is 
precisely the relative change from the copied cell (A4) to the pasted cell (B4). If you pasted from 
the cell A4 to the cell C9, the relative change would be two to the right and five down: thus, the 
pasted formula would be "=AVERAGE(C6:C8)".  

Figure 8

Figure 9 Figure 10
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6 Chapter 0 Getting Started

Coming back to our example, there is a faster way of copying one cell to multiple cells. 
The technique is called filling, and as with most things, there are several ways of accomplishing 
it. As noted earlier, every highlighted cell has a fill handle in the lower right-hand corner. If you 
hold-click this handle (grab) and drag in any direction, an automatic copy/paste is performed on 
all covered cells. In Figure 13 the handle in cell B4 is being grabbed and dragged across cells C4 
and D4. When the mouse is released, the average function is pasted into cells C4 and D4 with the 
appropriate adjustment to the address ranges within the function (Figure 14). 

There may be times when you will copy/paste a cell and you want one or more parts of 
the address ranges in the function’s arguments to remain unchanged. The trick is to use a “$” in 
front of every part of the address you want to freeze. For instance, suppose you are filling from a 
cell with the formula "=A1+B3-C7". If you do not want the column of the address A1 to change, 
you would instead use the formula "=$A1+B3-C7". If you do not want the row address of B3 to 
change, you would use the formula "=A1+B$3-C7". If you do not want the address C7 to change 
at all, you would use the formula "=A1+B3-$C$7". When an address is completely frozen, e.g. 
$C$7, this is called an absolute reference. When no part of the cell reference is frozen, e.g. C7, 
this is called a relative reference. When only part of a cell reference is frozen, e.g. $C7 or C$7, 
this is called a mixed reference.

j. Charts 

A picture is worth a thousand words. Spreadsheets are loaded with graphical tools for 
displaying sets of data. Creating a chart with sets of data is conveniently simple. Consider the 
data in Figure 15 of homework and test grades over the first four chapters. Select the data to 
be visualized (range B2:C5) and engage column charts via the “Insert” tab. There are many 
choices of possible charts, including bar charts (Figure 16 ), pie charts, and scatter plots.

Figure 11 Average function typed Figure 12 The next is copied from the first

Figure 13 The fill handle is dragged Figure 14 All averages are filled in
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You are given a vast number of choices to fine tune and annotate your graph. After 
the chart is created, changes can be made by simply right-clicking the part of the chart in 
which you are interested. If you left-click on the chart a new tab “Chart Tools” will appear, 
where you’ll find many options under “Format”. If you want to change format of letters in 
chart title, right-click on the title, and select “Format Chart Title” from the resulting menu.
You can also make any other major changes by right-clicking in the white area of the chart. 
A new tab “CHART TOOLS” will appear at the top. Click on it to obtain ribbon that allows 
you to change chart type, colors, switch row/columns, etc. Later in this manual you will see 
that by right-clicking the data graphics, one can even include trendlines.

k. Conclusion

Once you become comfortable with the spreadsheet environment, you should experiment 
with all the available charts, formulas, and built-in abilities. The possibilities for effectively and 
efficiently using Excel, or any other spreadsheet program, are practically endless. If you are 
using Microsoft Word or Microsoft PowerPoint, all tables and charts from Excel can be copied 
and pasted into a Word document or PowerPoint presentation so that you can create attractive 
papers and presentations. You can even import data from other programs and databases, as well 
as from the World Wide Web. Even though this manual only demonstrates how to use Excel for 
problems that arise in finite mathematics and in applied calculus, Excel also has applicability to 
other courses, including statistics, accounting, economics, biology, chemistry, and physics, just 
to name a few.
You may also find spreadsheets useful for keeping track of your college credits, personal finances, or 
even as an address book for e-mail and mailing addresses and phone numbers. You are limited only by 
your imagination and patience. 

Figure 15 Grades Figure 16 Bar chart
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Chapter 1 Solving Equations

a. Using the Quadratic Formula

One way to solve the quadratic equation 23 7 4 0x x is to calculate solutions by using 
the quadratic formula. 

If this procedure will not be frequently used, than the simplest is direct calculation. Once 
“=” is entered in a cell Excel will act as a calculator. Excel notation for square root is “SQRT”. 
Coefficients 3a , 7b and 4c entered in the formula as following will result in solutions 

1.33x and 1x .
“=(-(-7)+SQRT((-7)^2-4*3*4))/(2*3)” and  “=(-(-7)-SQRT((-7)^2-4*3*4))/(2*3)”
For frequent use of the quadratic formula it is recommended that we program cells to 

calculate quadratic equations solutions and save the file for future use. First step is to enter the 
coefficients 3a , 7b and 4c into cells as shown in Figure 17. Type the formulas bellow in 
cells D2 and E2 respectively to obtain the final solutions.

“=(-B3+SQRT(B3^2-4*A3*C3))/(2*A3)” and “ =(-B3-SQRT(B3^2-4*A3*C3))/(2*A3)”

To solve a different quadratic equation simply change the coefficients in the table and the 
new solutions will automatically be calculated in cells D2 and E2. 

b. Using SOLVER

To solve the cubic equation  3 22.7 10.5 013.6x x x we actually need to find value(s) 
of x that will result in 0y for the function 3 22.7 10.513.6y x x x .

Spreadsheet programs have a built-in add-in called “Solver". To use it in Excel you need 
to load it first. Click on “File” tab at the top left corner, and then click “Options”. Select “Add-
ins” and then in the Manage box, select “Excel Add-ins” and click “Go”. Check the “Solver” box 
and click “OK”. From now on the “Solver” Add-in will be listed under the “Analysis” group in 
the “Data” tab ribbon as shown in Figure 18.

Figure 17

Figure 18
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Chapter 1 Solving Equations 9

Solver will calculate the objective y’s for different values of variable x in the formula 
3 22.7 10.513.6y x x x until 0y is obtained. Assign an initial x-value for the adjustable cell 

B2 as shown in Figure 19. We selected “-7”, but any value may be used here. Enter the cubic 
function “=B2^3-2.7*B2^2-13.6*B2+10.5” in objective cell C2. Select “Solver” and fill the 
boxes as shown in Figure 19.

Click on “Solve” and the coordinates of the point where the function is maximized will be 
determined. In this example, the x-value 0.7 will appear in cell B2 and the y-value 0 appears in 
cell C2 as the coordinates of the solution of our cubic equation. To find the second solution pick 
a different initial x-value and use “Solver” again. In our example initial value 8 will produce the 
second solution 5x .The third solution is 3.

c. Solving Equations Using Graphs

We can read solutions of equation 21.5 10.5 02.25x x as x-intercepts of the function
21.5 10.52.25y x x . Excel will graph it, but we need to provide the list of x-values we are 

interested in. For this example, we are interested in values -4, -3.5, -3 etc. One fast way to list the 
x values under observation is to enter numbers -4 and -3.5 in cells A2:A3, then select cells 
A2:A3 together and then drag the fill handle from the lower right corner down over column A 
until cells A2:A18 are filled with the desired numbers. A simple way to list the y values under 
observation is to click into B2 and enter the formula " =1.5*A2^2-2.25*A2-10.5 ". Drag the fill 
handle over column B to copy the formula down. Values of variable y: 22.5, 15.75, 9.75, etc. 
will appear in cells B2:B18. Values of x and y are now sorted in the table. One of many ways to 
create a graph of our quadratic function is to first select cells A2:B18 together to indicate x and y
coordinates of the observed points. Select the “Insert” tab and then select the "Scatter" graph to 
the right. Select the chart sub-type "Scatter with smooth lines" as in Figure 20.

Figure 19
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10 Chapter 1 Solving Equations 

The final look of your graph is a matter of your personal taste. Click on your chart and 
the “Chart Tools” menu will appear. Use it to upgrade the style. Right-clicking on various 
sections of the final chart will let you select more options for gridlines, background color, text 
font, etc. Position your mouse exactly over one of the specially marked data points on your final 
graph, but do not click. After a short delay, the exact coordinates of that point will appear in a 
small gray box next to the point, like in Figure 21.

The graph shows that x-intercepts are -2 and 3.5. These values of x are solutions of 
equation 21.5 10.5 02.25x x .

Figure 20

Figure 21
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Chapter 2 Functions

a. Calculating Numerical Expressions

Spreadsheet can be used as a calculator once we use symbol “=”. To evaluate numerical 
expression “ 37.33 14 12 55.12 ” we type “=7.33^3-14*(12+55.12)” in any cell. The copy of 
your expression will appear in formula bar, next to xf . Enter. The result of calculation -545.847
will appear in the cell, as shown in Figure 22.

b. Using Function Notation

Excel allows us to create and use our own functions but it also has built-in functions that 
are performing various operations on data entered in cells. 

To calculate value (0.9)f for our own function 5 3( ) 1.8 3 7.3f x x x we enter the 
value of x in B2 and we enter the function in cell C2 as “=-1.8*B2^5+3*B2^3-7.3”. Figure 23
shows the final result (0.9) 6.17588f . In case of long algebraic expressions it is easier to 
type the function inside the formula bar. Notice that instead of x in the formula we are entering 
the value of cell B2. You can type “B2” or obtain the same by clicking on the cell B2. 

Once your function is entered, you can evaluate it for a different value of x, say 2.03x
by changing cell B2 value to 2.03. That way y value will change automatically to -44.2553.

The list of built-in functions is found in the name box, to the left from the formula bar, 
after you type symbol “=” in any cell. Click on arrow next to the name box to obtain the list, like 
in Figure 24. Click on “More Functions” to search over 100 built–in functions sorted in 
categories like “Statistics”, “Logical” etc., like in Figure 25.

Figure 22

Figure 23
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12 Chapter 2 Functions

Another way to find and insert a build-in function is by clicking on the tab “Formulas” 
and selecting a function from the ribbon, like in Figure 26. If you remember only the beginning 
of the name of the function, type it in a cell after “=”. The spreadsheet will help you remember 
the rest of the name by offering possible choices.

The built-in function “SUM” makes it easy to quickly sum columns, rows, or individual 
cells of data in a worksheet. To add numbers in cells A1:A4 we’ll type “=” and select built-in 
function SUM as in Figure 27. One easy way to tell Excel that you want the numbers in cells 
A1:A4 is by clicking on the small matrix to the right from the “Number1” box, and then 
selecting the array A1:A4.

c. Creating Function Tables

Excel can graph the function 3 5 1y x x after the table of (x, y) values of interest is 
created. Say, we are interested in y values of the function for 3.0, 2.5, 2.0,.....,2.5,3.0x .

Figure 24

Figure 25

Figure 27

Figure 26
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Chapter 2 Functions 13

Enter the first two values -3 and -2.5 in cells A2 and A3. One fast way to type the remaining x
values in column A is to select the array A2:A3 and drag the handle from the lower right corner 
down, over column A, until cells A4:A14 are filled with the desired x values, as in Figure 28.
Column B is reserved for the y values of our cubic function. A simple way to list the y values 
under observation is to click on B2 and enter the formula “=A2^3-5*A2+1”. Drag the handle 
from the lower right corner over column B as in Figure 29 to copy the formula down. Values -
11, -2.13, 3, etc. will appear in cells B2:B14.

d. Graphing Function

Once we have table of (x, y) values listed in cells A2:B14 we can work on a graph. One 
of many ways to create a graph of our cubic function 3 5 1y x x is to first select array
A2:B14 to indicate x and y coordinates of points under observation. Select the “Insert” tab and 
then in the ribbon select the "Scatter" graph to the right. Select the chart sub-type “Scatter with 
smooth lines and markers” as shown in Figure 30.

The final look of your graph is a matter of your personal taste. Click on your chart and 
the “Chart Tools” menu will appear as a new ribbon: use this to upgrade the style. Right-clicking 
on various sections of the final chart will let you select more options for gridlines, background 
color, text font, etc. Position your mouse exactly over one of the specially marked data points on 
your final graph, but do not click. After a short delay, the exact coordinates of that point will 
appear in a small yellow box next to the point, like in Figure 31.

Figure 28
Figure 29

Figure 30
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14 Chapter 2 Functions

e. Piecewise Functions 

To graph a piecewise defined function we’ll create table of (x, y) values we are interested 
in, insert graph, and then define the domain of each. As an example we’ll use the function:

2            if 2
6             if 2
10      if 2

x x
f x x

x x

Figure 32 shows table of values of all three functions: 2y x , 6y , and 10y x for 
4.0, 3.5, 3.0,....x To graph all three function together on 4,6 we select A2:D22 and 

inserted scatter graph with smooth lines.

Figure 31

Figure 32
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Chapter 2 Functions 15

The chart we obtained shows all three functions, each on the entire domain (-4, 4), as shown in 
Figure 33. We need to adjust the domain of each.

Right-click on “Series1” in legend under the graph and click on “Select Data”. The new pop-up
screen will help change the visible domain of the first function 2y x to 4,2 . Select 
“Series1” and “Edit” as in Figure 34.

The new pop-up screen allowed us to change “Series1” name to “x<2” in the legend. Click to 
encircled box matrix in Figure 35. In the new pop-up screen select the array A2:A14 to indicate 
that the first function domain is 4,2 . The final graph is shown in Figure 36.

Figure 33

Figure 34 Figure 35
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16 Chapter 2 Functions

f. Finding Intersection Points 

Suppose that the supply function is 0.2 51p q and the demand function is
3000 / ( 5)p q . We’d like to find the exact intersection point of these two functions (the 

equilibrium point). 

One way to do it is to look at the table of values 
and examine y values for supply and demand functions. 
The first two values of x that are 0 and 5 are entered in 
cells A2 and A3, then the array A2:A3 is copied down to 
cells A4:A42 by dragging the fill handle from the lower 
right corner. The functions are entered in cells B2 and C2 
as formulas “=0.2*A2+51” and “=3000/(A2+5)”, and 
copied down by dragging the fill handle. Figure 37 shows 
the equilibrium point in the table.

It is even better if we graph the functions together, and find the intersection point on the 
graph. To obtain the graph select cells array A2:B42 and then “Scatter with Smooth Lines” from 
the “Insert” tab ribbon. Position the cursor exactly above the intersection point, but do not click.
After a brief delay coordinates of the intersection point appear, like in Figure 38.

Figure 36

Figure 37
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Chapter 2 Functions 17

.

One more way to find the intersection point of functions 0.2 51p q and 
3000 / ( 5)p q is to find zeros of the function y (0.2 51) 3000 / ( 5)x x . Type “0” in cell 

H2 as shown in Figure 39 , and type the formula “=(0.2*H2+51)-3000/(H2+5)” in cell I2. Select 
“What-If Analysis” in “Data” tab ribbon. Click on “Goal Seek” and fill the obtained pop-up
screen as shown in Figure 40. Cell H2 value will change to 45, that is the first coordinate of the 
intersection point.

g. Finding Maximum and Minimum Points 

We can estimate the maximum of the function 
3 20.0037 0.0591 2.534 38.21y x x x by creating a spreadsheet table (see chapter 2 c) and 

examining y values. Once we have the table we might decide to graph the function (see chapter 2 
d) and position the mouse over the point. Coordinates (11, 54.0082) will appear as in Figure 41.

Figure 38

Figure 39 Figure 40
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By looking at the y values of marked data 
points from the graph, we can estimate that the 
percentage will be maximized where the x -value is 
between 10 and 11. Assume we'd like to know the 
exact maximum of our function. Spreadsheet 
programs have a built-in Add-in called Solver. To use 
it in Excel you need to load it first. Click on “File” 
tab, select “Options” and then select ‘Add-Ins’ the 
Microsoft Office Button at the top left corner, and 
then click “Excel Options”. Select “Add-ins”. After 
you load “Solver Add-In” to your “Add-Ins”, the 
“Solver”, command is available in “Data” tab ribbon 
as one of “Analysis” tools.

Excel’s command “Solver” will calculate y’s for different x values in the formula
3 20.0037 0.0591 2.534 38.21y x x x until the maximum or minimum value for y is 

found. Assign an initial x-value for the variable cell F2 as shown in Figure 42. We selected “3”,
but any value may be used here. Enter the quadratic function spreadsheet formula
“=-0.0037*F2^3-0.0591*F2^2+2.534*F2+38.21” in the objective cell G2. Select “Solver” and 
fill the boxes. Click on “Solve” and the coordinates of the point where the function is maximized 
will be determined. In this example, the x-value 10.7 will appear in cell F2 and the y-value 54.02
will in cell C2 as the coordinates of the maximum.

Figure 41

Figure 42
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Chapter 3 Exponential and Logarithmic Functions

a. Evaluating Powers of e

Powers of Euler’s constant e are calculated in Excel using the build-in function 
“=EXP( )”. It is one of many functions that will appear in the name box menu after typing “=” in 
a cell. This function is also found in “Formulas” tab ribbon as one of “Math & Trig” functions.

Say, a car value, x years after the purchase, can be modeled using the function
0.121679 xf x e .  To calculate the value of this car 5 years after the purchase we enter 

“=21679*EXP(-0.1*5)” in any cell. The result of this calculation is $13148.98.
 

b. Evaluating Expressions Involving Logarithms

We can calculate the natural logarithm of 73.5 by typing “=LN(73.5)” in any cell. The 
result of the calculation 4.297 will appear after entering. This function is also found in 
“Formulas” tab ribbon as one of “Math & Trig” functions.

The common logarithm (base 10) of number 334 is calculated by typing “=LOG10(334)” 
in any cell. The result is 2.524. This function is also found in “Formulas” tab ribbon as one of 
“Math & Trig” functions.

The logarithm of 3000 to base 2 is 11.55. This result is obtained in Excel by typing 
“=LOG(3000,2)” in any cell. This function is also found in “Formulas” tab ribbon as one of 
“Math & Trig” functions.

Copyright © 2015 Pearson Education, Inc. 
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Chapter 4 Regression

a. Linear Regression

Enrollment (in millions) for all US colleges and universities is given in the Figure 43.

Let x=5 correspond to year 2005. We’ll use a spreadsheet to find the regression line that 
models the data. Enter years x=5, 7, 8, 9, 10 in cells B2:B6 and enter the enrollment data y in 
cells C2:C6. Select cells B2:C6 and click the “Scatter” from the “Insert” tab ribbon, as shown in 
Figure 44.

Right-click one of the points from the newly obtained graph and select "Add Trendline", 
as in Figure 45.

Year 2005 2007 2008 2009 2010
Enrollment 17.5 18.2 19.1 20.4 21

Figure 43

Figure 44
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From the new pop-up screen, select the "Linear" graph and also check both "Display 
Equation on chart" and "Display R-squared value on chart" to obtain the graph shown in Figure 
46. The correlation coefficient 0.97r is the square root of the displayed value 2 0.9434R .

Notice that while adding the trendline, aside from selecting linear, you could select 
polynomial, exponential, or logarithmic regression. After the regression type has been selected, 
the Excel procedure for graphing non-linear regression and also displaying both the equation and 
the R2 value is the same.

Figure 45

Figure 46
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b. Quadratic Regression

The acreage (in millions) consumed by Forest Fires in the United States is given in Figure 47.

Let x=5 correspond to the year 1985. We’ll find the best-fit quadratic function that 
models the data using Excel. Enter x values 5, 8, 11,…in cells B2:B11 and y values 2.9, 5.0, 
3.0,… in cells C2:C11. Select cells B2:C11 and click the “Scatter” from the “Insert” tab ribbon. 
Right-click on any point of the graph and select “Add Trendline”. Since we want to obtain a 
quadratic model, select “Polynomial” and select “Order 2” as shown in Figure 48. Scroll down 
to check “Display Equation” and “display R-squared” as in Figure 49.

The graph that we obtained (Figure 50) shows that the quadratic model is
20.0067 0.0437 3.4338y x x , and that 0.5456 0.74r .

Year 1985 1988 1991 1994 1997 2000 2003 2006 2009 2012
Acres 2.9 5 3 4.1 2.9 7.4 4 9.9 5.9 9.2

Figure 47

Figure 50

Figure 48 Figure 49
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c. Exponential Regression

The table in Figure 51 shows the purchasing power of a dollar in recent years, with the 
year 2000 being the base year. We’ll use Excel to create an exponential regression model.

Enter values x=0, 1, 2,... for years 2000, 2001, 2002, …in cells B2:B1. One way to 
perform it easier is to enter 0 and 1 in cells B2 and B3 and selecting array B2:B3 and dragging 
the fill handle from the lower right corner over B4:B14 to copy the pattern. Enter values y=1.00, 
0.97, 0.96,… in cells C2:C14. Select cells array B2:C14. Click the “Scatter” from the “Insert” 
tab ribbon. Right-click on any point of the graph and select “Add Trendline”. Since we want to 
obtain an exponential model, select “Exponential” and scroll down to check “Display Equation” 
and “Display R-squared”. Figure 52 shows the result.

 

 

Year 2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 2011 2012
Purchasing power of $1 1.00 0.97 0.96 0.94 0.91 0.88 0.85 0.83 0.79 0.80 0.79 0.77 0.75

Figure 51

Figure 52
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Chapter 5 Systems of Linear Equations and Matrices

a. Matrix Addition and Subtraction

We’ll use Excel to perform operation A+B-C on matrices:

5.3 3 4.5 1.3 6 12.7 10 5 0
0 2 0.5   0 8 2   10 5 0
0 1 7 4 1 2 10 5 0

A B C

Type the matrix entries as shown in Figure 53. The result will be a 3x3 matrix: thus, 
highlight cells M2:O4 as the place for the future result. Type “=A2:C4+E2:G4-I2:K4”. Press 
“Ctrl+Shift+Enter” at the same time to obtain the final answer, shown in Figure 54.

A faster way to type the formula “=A2:C4+E2:G4-I2:K4” is to highlight the cells array A2:C4, 
then enter “+” then highlight E2:G4, then enter “-“and highlight I2:K4.

b. Scalar and Matrix Multiplication

We’ll use Excel to multiply the scalar and the matrix:

44 2 8
3

0.3 0 17

Type the matrix entries as shown in Figure 55. The result will be a 2x3 matrix, therefore, 
highlight cells E2:G3 as the place for the future answer. Type “=3*A2:C3”. Press 
“Ctrl+Shift+Enter” at the same time to obtain the final answer, shown in Figure 56.

Figure 53 Figure 54
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c. Product of Two Matrices

We’ll use Excel to find the product AxB for matrices:

5.3 3 4.5
2 0 1

0 2 0.5
  0 2 0.2   

0 1 7
8 0 17

6 6 6

A B

Type the matrix entries as shown in Figure 57. The result will be a 4x3 matrix, 
therefore, highlight cells J2:L5 as the place for the future answer. Type 
“=MMULT(A2:C5,E2:G4)”. Press “Ctrl+Shift+Enter” at the same time to obtain the final
answer, shown in Figure 58 .

d. Inverse of a Matrix

We’ll use Excel to find inverse of matrix A:

2 0 1
0 2 0.2   
8 0 17

A

Figure 55 Figure 56

Figure 57 Figure 58
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Type the matrix entries as shown in Figure 59. Highlight cells E2:G4 as the place for the 
future answer. Type “=MINVERSE(A2:C4)”. Press “Ctrl+Shift+Enter” at the same time to 
obtain the final answer, shown in Figure 60.

Format cells to fractions if needed, by right-clicking and selecting “Format Cells.”

e. Determinant of a Matrix

We’ll use Excel to find inverse of the matrix:

2 0 1
0 2 0.2   
8 0 17

A

Type the matrix entries as shown in Figure 61. Type “=MDETERM(A2:C4)” in any cell 
and enter. 

f. Solving System Using Matrices

We’ll use Excel to solve the system:
1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 4 5

  2 3 2 2 6
2 3  3   22
3  4 3     0
  2 3 4 2   0
2                   4 5 7

x x x x x
x x x x x
x x x x x
x x x x x
x x x

Figure 59 Figure 60

Figure 61
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Type the coefficients and constants as 
shown in  Figure 62. To find inverse of 
the coefficients matrix highlight cells 
A9:E13 as the place for the future 
inverse. Type “=MINVERSE(A2:E6)”. 
Press “Ctrl+Shift+Enter” at the same 
time to obtain the inverse. 

If we multiply the inverse matrix by the constants matrix, the result will be the solutions matrix. 
Highlight cells G9:G13 as the place for the future solution matrix. Type 
“=MMULT(A9:E13,G2:G6)”, press “Ctrl+Shift+Enter” at the same time and the solution 

1 2 3 4 51,   2,   3,   4,   5x x x x x will appear in cells G9:G13.

Figure 62
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Chapter 6 Linear Programming

a. Graphing an Inequality 

To graph the inequality 2 5y x in Excel we need to plot the line 2 5y x . Enter x
values -5, -4, -3 …in A2:A15. Enter the formula “=2*A2-5” in cell B2 and copy it down to cells 
B2:B15 to obtain y values. Highlight x-y coordinates in A2:B15. From the “Insert” Tab select
“Scatter with Smooth Lines”, as shown in Figure 63.

Shading the half plane is done using “Freeform” graphical tool from “Shapes”, found as 
in Figure 64. Click on the three corners to define the triangular shape of the half plane. To 
change the transparency of the triangular shade of the half plane, click on it. The “Drawing 
Tools” tab will appear. Click on “Format Shape” that is a small box in bottom-right corner of 
“Shape Styles” as in Figure 65. Change the transparency of the shape in the new menu that will 
appear to the right.

Figure 63

Figure 64 Figure 65
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The graph of the inequality 2 5y x is shown in Figure 66.

b. Graphing Systems of Inequalities 

We’ll graph the following system of inequalities

To graph the corresponding lines, first enter x values -3, -2, -1 …in cells A2:A8. To 
calculate y values for the first line points enter the formula “=-2*A2+1” in cell B2, and copy it in 
cells B3:B8. An easy way to do it is by dragging the fill handle from the lower right corner. To 
calculate y values for the second line points enter the formula “=(3/2)*A2-1” in cell C2, and 
copy it in cells C3:C8. Highlight x-y coordinates in cells array A2:C8. From the “Insert” tab 
ribbon select “Scatter with Smooth Lines”. The second line should be dashed. Right-click 
exactly on the second line and select “Outline” as shown in Figure 67 . One of options that will 
appear is “Dashes”.

Figure 66

2 1  
3 1
2

y x

y x

Figure 67
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Shading the half plane is done using “Freeform” graphical tool from “Shapes” in “Insert” 
tab ribbon. Click on the corners to define the shaded shape. To change the transparency of the 
shaded area of the half plane, click on it. The “Drawing Tools” tab will appear. Click on “Format 
Shape” to change the transparency of the shape. Figure 68 shows the final result.

c. Maximization 
 

We’ll solve the following linear programming problem: 

Maximize  8 12
subject to    40 80 560
                     6  8 72
                       0, 0

z x y
x y
x y
x y

Excel's “Solver”, one of add-ins, can quickly find solutions to linear programming 
problems of all types. Here is how it works: In case that we select x=0 and y=0 the value of 
objective function is 8 0 12 0 0z and both constraints are satisfied since 
40 0 80 0 560 and 6 0 8 0 72 . Solver will keep changing values of x and y until the 
maximal value of objective function z is obtained.

Figure 68
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Enter the linear programming problem information as shown in Figure 69. If you entered 
everything correctly, cells B3, B6 and B7 will be showing zeros.

Select “Solver” from the “Data” tab ribbon “Analysis” tools and fill entries in the 
following way: first check box ‘Make Unconstrained Variables Non-Negative’ since our x and y
values cannot be negative. The next step is to define the first constraint. Click on “Add”, and a 
new window will appear with three empty boxes as in Figure 70.  Click on the constraint cell 
B6 to define it as “Cell Reference”, then click on arrow in the middle and select “<=” from the 
drop-down menu, and finally type 560 in  the “Constraint” box as it is the maximal value that 
cell B6 may assume. To define the second constraint, click on “Add”, and a new window will 
appear with three empty boxes. Click on the constraint cell B7 to define it as “Cell Reference”, 
then select "<=" from the drop-down menu, and finally type 72 in the "Constraint" box as it is 
the maximal value that cell B7 may assume. Click “OK”. Set the remaining as shown in Figure 
71. The empty “Set Objective” box was filled by clicking on B3. An easy way to fill the empty 
“By Changing Variable Cells” is to select B10:B11. Click on "Solve" to obtain the final answer 
x=8 and y=3 as shown in Figure 72.

Figure 69
Figure 70

Figure 71 Figure 72
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Chapter 7 Mathematics of Finance

a. Compound Interest

A spreadsheet can be used to compare two interest schemes. We’ll create a table with one 
column showing the growth of $1,000 investment at an annual rate of 10% and another column 
showing the maturity value with simple interest. Enter appropriate column headings to represent 
years, amount compounded annually, and simple interest amount. Fill column A with the 
numbers 1 through 20 to indicate the years since the principal was invested. An easy way to 
perform it is to enter “1” and “2” in cells A2 and A2, then select cell array A2:A3 and drag the 
fill handle from the lower right corner over cells A4:A21. 
If $1,000 is invested at a rate of 10% compounded annually, the future value of the money is

11000(1 0.1 /1) 1000 1.1t tA where t is the number of years. Thus, enter the formula 
“=1000*1.1^A2" in cell B2. Copy the formula into cells B3:B21. An easy way to do it is by 
dragging the fill handle from the lower right corner of the cell, shown in Figure 73.

If the same amount is invested at a simple interest rate of 10%, then the future value of 
the money is 1000(1 0.1 ) 1000 100A t t . Enter the formula "=1000+100*A2" in cell C2. 
Copy the formula into cells C3:C21. The first 6 rows of the resulting table are shown.

b. Effective Rate

Excel has many built-in functions for calculating financial values. These functions are 
located in the "Financial" submenu of the "Function" menu. 

Bank A offered its costumers 10% interest compounded annually, bank B offered 9.6% 
interest compounded monthly, while bank C offered 9.7% interest compounded quarterly. 
We’ll use Excel built-in function "EFFECT(nominal_rate,npery)" to calculate the lowest APY. 
Type the following in any blank cell in a worksheet: 

"=EFFECT(0.1,1)" to obtain APY of 0.1=10% at bank A,
"=EFFECT(0.096,12)" to obtain APY of 0.100339=10.0339% at bank B,
"=EFFECT(0.097,4)" to obtain APY of 0.100586=10.0586% at bank C.

Figure 73
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c. Present Value for Compound Interest

The "PV" function calculates the present value of an account, when the nominal interest 
rate, total number of interest payments, and the future value of the account are known. In any 
empty cell, type "=", then click on arrow in the Name Box and select the function "PV" from the 
"Financial" submenu. A pop-up window will appear (see Figure 74). Another way to find it is 
under “Financial” in “Formulas” tab ribbon.

We’ll calculate what amount deposited today at 4.4% compounded quarterly will amount 
to $6,000 in 7 years. Enter the interest rate per compounding period, as a decimal 0.044/4=0.011 
(Rate); the total number of compound periods over the life of the account 7x4=28 (Nper); the 
amount that will be paid into the account by the account holder at the beginning of each period 0 
(Pmt); then the desired future value of the account 6,000 (FV). Notice that “1” was entered as the 
type of the account. This indicates that the account holder will make a payment at the beginning 
of a period. However, in this example, the account holder will be making only one payment, not 
periodic payments; this is why “0” was entered for “Pmt”. When you click “OK”, the resulting 
present value of $4,416.91 will appear in the selected cell. This value will be shown as a red
value, since this amount must be paid out by the account holder.

d. Future Value of the Ordinary Annuity

Excel has a built-in function, "FV", for calculating the future value of an ordinary 
annuity. This function is also located in the "Financial" collection of functions. From an empty 
cell, type "=", then click on arrow in the “Name Box” and select the function "FV" from the 
"Financial" submenu. Another way to find it is under “Financial” in “Formulas” tab ribbon. If 
you remember the exact name of this function, simply type it in any cell after entering “=”.

We’ll calculate the future value of the annuity if $1,500 is deposited at the end of each 6-
month period for the next 5 years in an account paying 4% interest compounded annually. 
Figure 75 shows the appropriate values for this example. 

Figure 74
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The annual interest rate per compounding period was entered as a decimal 0.04/2=0.01 (Rate), 
while the total number of compound periods over the life of the account was 5x2=10 (Nper). The 
payment, “Pmt”, is entered as a negative number since this amount will be paid out by the 
account holder. Also note that for an annuity “0” should be entered as the present value.  This 
time “0” was selected as the “Type”, since the money will be deposited at the end of each period. 
The future value is $16,424.58.

e. Future Value of the Annuity Due

Excel’s built-in function, “FV” will calculate the future value in case when $1,500 is 
deposited at the beginning of each 6-month period for the next 5 years in an account paying 4% 
interest compounded annually. From an empty cell, type “=”, then click on arrow in the “Name 
Box” and select the function FV from the "Financial" submenu. Another way to find it is under 
“Financial” in “Formulas” tab ribbon. Figure 76 shows the appropriate values for this example. 
Note that for an annuity due “1” should be entered as the “Type”. The future value is $16,753.07.

Figure 75

Figure 76
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f. Amortization Payments

Excel has a built-in function that will calculate the monthly mortgage payment for the 
family that purchased a home for $272,900, with the down payment of 20%. They take out a 30-
year mortgage at an annual interest rate of 3.43%. From any empty cell, type “=”, then click on 
arrow in the Name Box and select the function "PMT" from the "Financial" submenu. A pop-up
window will appear. Fill the entries as indicated in Figure 77. The monthly payment is $971.84.

g. Amortization Schedules

To determine the exact remaining balance after each loan payment, financial institutions 
normally use an amortization schedule, which lists how much of each payment is interest, how 
much goes to reduce the balance, and how much is still owed after each payment.

We’ll create an amortization schedule for Beth Hill, who borrowed $1,000 for one year at 
12% annual interest, so her monthly payments are $88.85 each. Enter the appropriate column 
headings, like in Figure 78. Fill column A with the numbers 0 through 12, indicating the 
payments for this example. At this point, you may wish to format the cells in columns B, C, D, 
and E so that numerical values are displayed as currency. “Chapter 0 Getting Started” of this 
manual explains the formatting. In cell E2, enter the amount of the loan, $1000. Since monthly 
payments are $88.85, fill cells B3:B14 with this amount. Since interest is 1% per month (12% 
compounded monthly), enter the formulas into the cells C3, D3, and E3 as shown in Figure 78.

Drag the fill handle from the lower-right corner of cell C3 to fill the rest of column C. Do 
the same for columns D and E. The resulting amortization schedule table is featured in the 
Figure 79.

Figure 77

Figure 78
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Figure 79
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Chapter 8 Probability

a. Factorial, Permutations, Combinations

To calculate factorial “9!” enter “=FACT(9)" in any empty cell. The result is 362880. If 
you cannot remember the name of the function, find it in the “Formulas” tab ribbon, among 
“Math & Trig” functions, or find it using arrow in the “Name Box” that appears after entering 
“=” in any cell.

To evaluate the number of permutations “8P3” type the following in any empty cell 
"=PERMUT(8,3)". The result is 336. If you cannot remember the name of the function, go to tab 
“Formulas”, click on “Insert Function” and find it among “Statistical” functions.

To evaluate the number of combinations “15C12” type the following in any empty cell 
"=COMBIN(15,12)". The result is 445. If you cannot remember the name of the function, go to 
tab “Formulas”, click on “Insert Function” and find it among “Statistical” functions.

b. Expected Value

The table in Figure 80 gives each possible outcome of a raffle drawing and the 
corresponding probabilities. To calculate the expected value of winning from this example, click 
on an empty cell and type “=”. The arrow in the Name Box will help you locate the function 
"SUMPRODUCT(Array1,Array2)" from the "Math & Trig" submenu. Select the x values from 
the table B2:E2 for "Array1", and select their corresponding probabilities for "Array2", as 
shown.  Excel will then multiply each entry from Array1 with its corresponding entry from 
Array2, and subsequently add all such products. A faster way is to type 
“=SUMPRODUCT(B1:E1,B2:E2)” in any cell.  The result of this calculation shows that, on 
average, one would lose $.74 per ticket.

c. Binomial Probability

A 9-person jury acts independently of the other members and makes correct decision with 
probability 0.65. We’ll find probability that the majority (at least 5) will reach the correct 
decision.

Excel has a built-in function, "BINOM.DIST" that allows binomial probabilities 

Figure 80
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calculations. From an empty cell insert the function “BINOM.DIST" by clicking “=” and then 
using arrow in the Name Box to list offered functions. You can also find it in the “Formulas” tab 
ribbon, among “Math & Trig” functions, or using arrow in the “Name Box” that appears after 
entering “=” in any cell.

Figure 81 shows the appropriate values for completing this example. The value “1” is 
used in the last text box to indicate that we are calculating the cumulative probability ( 4)P x .
Click on “OK” and the Excel calculation will show that the probability of 4 or fewer jurors 
making the correct decision is 0.171719. By subtracting this number from 1, we get 0.828281: 
this is the probability that at least 5 of the jurors will make the correct decision.  

Figure 81

Copyright © 2015 Pearson Education, Inc.



Chapter 9 Statistics 39

Chapter 9 Statistics

a. Frequency Distributions

The annual tuition in thousands for a random sample of 40 community colleges is:

3.8 1.1 2.5 3.5 4.0 3.8 3.9 4.2 3.1 3.9
5.0 1.1 2.0 3.4 3.5 1.1 2.3 4.8 1.1 3.1
3.5 5.1 3.3 3.2 2.1 5.3 2.6 2.3 2.5 3.6
4.9 3.0 2.4 3.6 3.1 3.7 5.1 3.5 2.0 4.4

To create a frequency histogram with Excel, begin by creating the frequency table. First 
enter the tuition in cellsA2:A41. Enter "1.4" in cell B2 to indicate that the upper bound of the 
first frequency interval 1.0-1.4 is 1.4. Enter "1.9" in B3 to indicate that the upper bound of the 
second frequency interval 1.5-1.9 is 1.9 and so on. Select cells C2:C10 to display the frequency 
column. Type “=” and insert the function "FREQUENCY" from the functions menu in the Name 
Box as in Figure 82. Fill the data as shown. Press CONTROL+SHIFT+ENTER simultaneously 
to finish the frequency table. 

The newly created frequency table in cells C2:C10 will be used to draw histogram. We 
want to show the frequency intervals on the x-axes of our histogram. That is why we’ll enter 
them in column D.

Select the frequency values in cells C2:C10 from the table and click on the "Insert" tab. 
Use the "2-D Column" chart as in Figure 83 and your chart will appear. 

Figure 82
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To define what will be seen on the x-axis click anywhere on the graph. The Chart Filter 
will be one of three symbols that will appear to the right from the chart area. Double-click it and 
then click on “Select Data” at the bottom of the new window. Click on “Edit” shown in Figure 
84 and select cells D2:D10 instead as your choice of x-axis labels in the new window as in 
Figure 85.

To make your bars wider, click on one of them and right-click. Select “Format Data 
Series” and change “Gap Width” to a desired “0”. Figure 86 shows the histogram.

Figure 83

Figure 84 Figure 85
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The frequency polygon might be created by following the same routine, except for using 
"Line Chart" instead of "Column Chart" from the Chart Wizard standard chart types. 

b. Mean, Median and Mode

The built-in function, “AVERAGE”, will calculate the arithmetic mean. To find the mean 
of numbers 1248, 1362, 1800, 1943, 1951 type the numbers in cells A1:A5. Type 
“=AVERAGE(A1:A5)” in any cell. The mean of 1669.8 will appear after entering. This function 
might be also found in the “Functions” tab ribbon as one of the “Statistical” functions. If you 
remember the beginning of the name of the function type it in any cell after the symbol “=” and 
Excel will help you remember the rest by offering you choices.

The mean of data that has been arranged into a frequency distribution table is found in a 
similar way. An instructor collected data on the age of her finite mathematics class students and 
the frequency of each age. The age is entered in cells A2:A6 while their frequencies are entered 
in cells B2:B6. The mean of 19.1 will be obtained by using the formula: 
“=SUMPRODUCT(A2:A6,B2:B6)/SUM(B2:B6)”, as shown in Figure 87.

The mean from the grouped frequency distribution is calculated in a similar way. The 
annual tuition in thousands for a random sample of 40 community colleges is grouped by tuition 

Figure 86

Figure 87
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intervals and sorted in a frequency table. Excel will calculate midpoints automatically. 
To prepare our data first separate endpoints of intervals into two columns, C and D. Type 

the left endpoints of intervals in cells C2:C10, and type the right endpoints in cells D2:D10 as in
Figure 88. Cell E2 will contain the midpoint x of the first interval after entering the formula 
“=(C2+D2)/2”. Copy this formula through cells E3:E10 to apply the formula for midpoint to all 
given intervals. A fast way to do it is by dragging the fill handle in the lower right-hand corner 
over column D. To find the mean from the grouped frequency distribution it is helpful to use the 
built-in function, “SUMPRODUCT” from the “Math & Trig” submenu. This function will 
multiply midpoints E2:E10 with their corresponding frequencies B2:B10 and then add all such 
products. To obtain the mean from the grouped frequency distribution the result of this 
calculation should be divided by the sum of all frequencies, found in cells B2:B10. The formula 
“=SUMPRODUCT(B2:B10,E2:E10)/SUM(B2:B10)” entered in any cell will return 3.3, which is 
the mean of the grouped frequency distribution. 

To find the median of numbers 12, 7, 10, 20, 22, type the numbers in cells A1:A5, type 
"=MEDIAN(A1:A5)" in any cell. The result is 12. If you cannot remember the name of the 
function, go to tab “Formulas”, click on “Insert Function” and find it among “Statistical” 
functions.

To find the mode of numbers 13, 7, 13, 20, 22, type the numbers in cells A1:A5, type 
"=MODE(A1:A5)" in any cell. The result is 12. If you cannot remember the name of the 
function, go to tab “Formulas”, click on “Insert Function” and find it among “Statistical” 
functions.

c. Measures of Variation

To find the sample variance of numbers 2, 8, 3, 2, 6, 11, 31, 9, type the numbers in cells 
A1:A8, and type "=VAR.S(A1:A8)" in any cell. The result is 90.28571. If you cannot remember 
the name of the function, go to tab “Formulas”, click on “Insert Function” and find it among 
“Statistical” functions.

To find the sample standard deviation of numbers 2, 8, 3, 2, 6, 11, 31, 9, type the 
numbers in cells A1:A8, then type and enter "=STDEV.S(A1:A8)" in any cell. The result is 

Figure 88
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9.50188. The tab “Formulas” ribbon is another place where you can find this function. 

On the other hand, if you're working with the entire population, you calculate the 
standard deviation using "=STDEV.P(A1:A8)". The result is 8.889.

The annual tuition in thousands for a random sample of 40 community colleges is 
grouped by tuition intervals and sorted in a frequency table. We’ll find the standard deviation for 
the grouped data.

Previously we showed how to use a spreadsheet to calculate midpoints as averages of 
endpoints. To calculate the mean for the grouped distribution the following formula was used: 
"=SUMPRODUCT(B2:B10,E2:E10)/SUM(B2:B10)" in cell H2. The resulting mean was 3.3x .

The function "=SUM(B2:B10)" entered into H5 will add the frequencies giving us the 
final result n=30. We can calculate  for each interval by entering the formula "=B2*E2^2" 
in cell F2 and dragging the fill handle in the lower right-hand corner over column F. The sum of 
these values will be calculated by using the formula "=SUM(F2:F10)" in cell H8. The value of s
will be calculated using the formula 2 2 / 1fx nx n . Enter “=SQRT((H8-

H5*H2^2)/(H5-1))"  in H11 to obtain  1.1163s . Figure 89 shows the final table. 

If you only know frequency values f in column B and midpoints x in column E, and 
you'd like to calculate the standard deviation for grouped data directly, click on any empty cell 
and enter the formula  “=SQRT(((SUMPRODUCT(B2:B10,E2:E10^2)-
((SUMPRODUCT(B2:B10,E2:E10))^2/SUM(B2:B10)))/(SUM(B2:B10)-1)))”.
This is the formula for the standard deviation for a grouped distribution from your text after 
n f and  /x fx f is used in it, and it can be simplified to:

22 / / 1s fx fx f f .

Figure 89
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d. Normal Distributions

Excel has a built-in function that returns cumulative areas under the normal standard 
curve. We’ll use it to find the area between z=0 and z=1.4. Entering “=NORMSDIST(1.4)” in 
any empty cell will return the answer 0.919243, which is the area shaded in Figure 90. The area 
between z=0 and z=1.4 is calculated as 0.919243-0.5=0.419243. If you cannot remember the 
name of the function, go to tab “Formulas”, click on “Insert Function” and find it among 
“Statistical” functions.

To graph the normal standard curve enter -3.4, -3.2, -3, -2.8… 3.2, 3.4 in cells A1:A35, 
then insert the formula “=NORM.DIST(A1,0,1,0)” in B1 and copy it in cells B2:B35. Select 
cells A1:B35 and insert “Scatter with Smooth Lines” graph. One easy way to shade the area 
under the graph is by using “Freeform” illustrations tool from the “Insert” tab.

For the normal distribution that has mean of 6 and standard deviation of 12, we’ll 
determine what percentage of the distribution occurs for x less than or equal to 9. For that reason 
we’ll use the function”=NORM.DIST(x, mean, standard_dev, cumulative)” from the statistical 
menu. Entering“=NORM.DIST(9,6,12,1)” in any empty cell will return answer 0.5987, which is 
the area shaded in Figure 91

To graph the standard curve with mean of 6 and standard deviation of 12enter -30, -27, -
24, -21,…, 45, 48 in cells  A1:A27, then insert the formula “=NORM.DIST(A1,6,12,0)” in B1 
and copy it in cells B2:B27. Select cells A1:B27 and insert “Scatter with Smooth Lines” graph. 
One easy way to shade the area under the graph is by using “Freeform” illustrations tool from the 
“Insert” tab. 

Figure 90

Figure 91
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e. Boxplots

Excel doesn’t have a built-in boxplot graphing tool, but we can still use a modified 
stacked bars to create such a graph after a careful data preparation. We’ll compare the revenues 
in billions by graphing the data:

We’ll prepare our data by creating the three tables and entering data and formulas as 
shown in Figure 92. Copy the summary table cells F2:F6 for Home Depot into G2:G6 cells for 
Lowe’s to apply the same group of formulas. Do the same in “Data for Chart” table.

Select cells I1:K5 and insert the “Stacked Bar” chart. 

Year 2004 2005 2006 2007 2008 2009 2010 2011 2012 2013
Home Depot 64.8 73.1 81.5 90.8 66.2 71.3 66.2 68.0 70.4 74.8

Lowe's 30.8 36.5 43.2 46.9 47.2 48.2 47.2 48.8 50.2 50.5

Figure 92

Figure 93
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Notice that the last row from the Data Chart was not selected. Click anywhere on the 
graph and the Chart Tools tab will appear. Click on “Switch Row/Column” to obtain the graph 
from Figure 93.

Left-click on the blue area of one of the chart bars, then right click to obtain the “Fill” 
selection menu. And the “Outline” selection menu. Check boxes “No Fill” and “No Outline” to 
visually remove the blue part of bars, as in Figure 94. Do the same for the next, brown area, but 
this time stay in this area since we’ll change it into “Error Bars”. In “Chart Tools” tab select 
“Add Chart Element” from the ribbon. Pick “Error Bars” from the menu, and then select “More 
Error Bars Options”. A new menu will appear to the right. Select buttons “Minus” and 
“Percentage”. Change the percentage to 100. The first set of whiskers will appear, as in Figure 
95.

To create the second set of whiskers, first click on the last, orange part of bars. Again go 
to “More Error Bars Options”, but this time select buttons “Plus” and “Custom”.  Click on 
“Specify the Value”. In the “Positive Error Value” name box use cells J6:K12 since they 
represent the right hand value of whiskers. The final box plot is shown in Figure 96.

Figure 94 Figure 95

Figure 96
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Chapter 10 Differentiation

a. Limits

Excel is an excellent tool for learning explorations of limits. We’ll examine the function 
3 35 7 / 2 3f x x x x as x is approaching infinity. For our table we choose x values 5, 50, 

500, 5000, 50000, 500000 and enter them in cells A2:A7. Type the formula 
“=(5*A2^3-7*A2)/(2*A2^3+3)” in cell B2 and copy it in cells B3:B7. The resulting y values are 
shown in Figure 97.

b. Rate of Change

We’ll use a spreadsheet to create an interactive table of rates of change for the function
20.5f x x . Change of x1 and x2 values in cells A2 and B2 will result in change of the average 

rate of change and instantaneous rates of change at x1 and x2 in the table. To create such a table, 
enter any two values in cells A2 and B2. Enter the formulas for our function as shown in the 
Figure 98.

The final table for values x1=2.3 and x2=2.5 is shown in Figure 99. To create an 
interactive table that will help us examine rates of change for a different function, say 3f x x ,
we need to change formulas. In that case C2 cell formula would become 
“=(B2^3-A2^3)/(B2-A2)”,  D2 cell formula would be “=3*A2^2”, while E2 formula would be 
“=3*B2^2”. 

Figure 97

Figure 98
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A spreadsheet might be used to create an interactive graph of function and its tangent. 
We’ll make it for the function 20.5f x x , but any function can be used. Change of x1 value in 
cell A1 will result in change of the tangent line on the graph. To create such a graph, enter any 
value in cell A2, then enter the formulas for our function as shown in the Figure 100. Drag 
handles down one by one as shown to copy formulas over columns D2:D14, also E2:E17 and 
F2:F17. Notice that the symbol “$” is used to “freeze” some values. They will remain the same 
when the formula is copied. Otherwise they’d adjust to the cell position.

Select cells D2:F14 and insert scatter chart with smooth line. The resulting graph in 
Figure 101 shows the tangent line of the function 20.5f x x at x1=1.5. 

Figure 99

Figure 100

Figure 101
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Change the x1 value in the table to obtain a different tangent. To adjust the view of values 
on y axis to (-1,5), double-click on any number labeling y axis and a new menu “Format Axis” 
will appear to the right. Adjust the “Axis Options” (bars icon) bounds minimum and maximum 
values to -1 and 5.  

We can also use a spreadsheet to create an interactive graph showing secant tangents 
together for the function 23 0.4f x x . Enter values as shown in Figure 102 and drag the 
corner handles as indicated.

Select cells G2:K14 and insert scatter chart with smooth line. The resulting graph in 
Figure 103 shows the secant and tangent lines at x1=-0.3 and x2=1.5. Change these values in 
cells A2 and B2 to see secant and tangents move. 

Figure 102

Figure 103
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c. Extrema of Functions of Several Variables

We'll use Excel to find the local minimum of the function
2 2, 6 6 6 36 54 5f x y x y xy x y . For that reason we’ll use a built-in add-in called 

“Solver”, described in detail in Chapter 1. After installing it, it can be located under the 
“Analysis” group in the “Data” tab ribbon.  Solver will calculate z (the target cell) for different x
and y values (the adjustable cells) until the minimum value for z is found. 

Assign initial values for adjustable cells x and y. We selected "1" and "1" for initial 
values, but any value may be used here except the coordinates of the saddle point, since such 
selection would block further Excel calculations. Enter the formula 
“=6*A2^2+6*B2^2+6*A2*B2+36*A2-54*B2-5” in target cell C2. Click on a cell and click on 
“Solver”. Fill the boxes as shown in Figure 104. Uncheck the box “Make Unconstrained 
Variables Non-Negative” since we are looking for the solution among negatives also.

To obtain a solution, click on "Solve" and the optimal values, if they exist, will be 
determined. In this example, the x-value -7 appears in cell A2, the y-value 8 appears in cell B2, 
and the minimum z-value -347 appears in cell C2. 

d. Lagrange Multipliers

Using a spreadsheet we'll maximize the function 2, ,f x y z xyz subject to the constraint
50x y z . Assign your choice of initial values for variables x, y, and z and enter them in 

cells A2, B2, and C2. Notice that some initial values will block Excel from further calculations. 
If this is the case, change the selection and start again. Enter the formula “=A2*B2*C2^2” in cell 
D2. Enter the formula "=A2+B2+C2" into cell E2. Click on a cell and select "Solver”. Fill the 
newly appeared pop-up screen as shown in n Figure 105.

Figure 104
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Click on "Add" and a new dialog box will appear where the constraint 50x y z
will be entered as shown in Figure 106. Fill the "Cell Reference" box by clicking on E2. Select 
"=" from the drop bar in the middle. Set the value in cell E2 to 50, as this will be the right hand 
side of the constraint equation. 

Click "OK" and "Solve" to obtain the final answer x=12.5, y=12.5, z=25 and , , 97656f x y z .

Figure 105

Figure 106
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Chapter 11 Integrals

a. Numerical Integration

Excel doesn’t have a build-in function that calculates integrals, but we can easily 
approximate a definite integrals by performing numerical integration. To approximate the 

integral 
2.6

2

0

x dx enter x values 0, 0.1, 0.2, 0.3… 2.5, 2.6 in cells A2:A28. One way to do it fast is 

to type the first two entries, select cells A2:A3 together and then drag the black corner marker 
over cells A4:A28 to copy the pattern.  The integral will be approximated as the sum 

1 2 27...f x x f x x f x x where 1 2 27, ,...,x x x are midpoints and 0.1x . For that 
reason enter the formula “=0.1*(A2+0.05)^2” in cell B2. Copy this formula to cells B3:B27 by 
dragging the black corner marker as in Figure 107.

Enter the formula “=SUM(B2:B27)” in any cell to obtain the final answer 5.8565.  The 
exact value of this integral rounded to 4 decimal places is 5.8587.

To estimate an integral of a different function on a different interval change the formula 

in cell B2 and adjust the formula in cell D2. For example, to approximate 
1.7

0

x dx use 

“=0.1*(A2+0.05)^0.5” and “=SUM(B2:B19)”.  
To obtain a more accurate approximation of the first integral use x values 0, 0.05, 

0.1….and use “=0.05*(A2+0.025)^2” in cell B2.  

b. The Definite Integral 

We’ll create an interactive spreadsheet that will help explore the definition of definite 
integral. The interactive spreadsheet will calculate the sum of areas of rectangles for a different 
choice of n. As the number of rectangles n is increasing, the sum of areas of rectangles is 
becoming more accurate approximation of area under the curve. Our spreadsheet is created to 
work with the function 5 /f x x , but other functions might be used after adjustment of cell 
G2. The choice of the interval endpoints x1 and x2 is also interactive

Figure 107
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Enter values and formulas as indicated in Figure 108. Drag the corner handle down up to 
row 17 to copy pattern (column E) or to copy a formula (columns F, G, and H). 

If created exactly as in Figure 108, our interactive spreadsheet calculates approximation 

of
5

1

5 dx
x

, using n=10 rectangles, each 0.4 wide. The approximation in cell I2 is 8.016. Change 

the number of rectangles in cell C2 to n=16, and the new integral approximation will be 8.035, as 
shown in Figure 109. The exact value rounded to 3 decimal places is 8.048.

We can add a graph of rectangles by selecting y-coordinates from column G, and 
inserting “Clustered Column” graph. Right-click on any number on x-axis and pick “Select 
Data”. In the newly appeared pop-up screen click on the right-hand “Edit” and select x
coordinates from column F. To adjust the appearance of x-axis after change of n, click on graph 
and then click on the small image of filter that will appear to the right.  To make bars wider, 
right-click on any bar and then click on “Format Data Series”. Change the “Gap Width” is one of 
“Series Options”.

Figure 108

Figure 109
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To estimate an integral of a different function change the formula in cell B2 and adjust 

the formula in cell G2. For example, to approximate 
5

1

x dx use “=IF(E2<$C$2+1,F2^0.5,0)”.
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